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`��,9)�	����"��$.�*� �

At Each Girder Location ����y�����������������	����"��$.���$#%����%�,9)������
���)�����	��&��*� �

Equally Spaced Over Bridge With�y�g���	�����()�	
`���	��/%�"��$.�����C����%�������

�	� �����%���)�	��&�*������C���6���7��	����%�"��$.���/����)��	����	�2$ �������������(�.��	
�`���	���/1�����;�:���

�)�2$c ��� �*� �

� �

�	���"	�����@����5	1A9��+�3��+�	���� �

������	��> Add New Bridge  Bent�Bridge >Bent������Q �FGv��
���)����!1*��� �

� �

� �
���Q �FGv� �

� �

:Bridge Bent Name�����	����	��	�$#���=�1���������)��
�&��	�g�:�V$��=�1�����2$ �*� �

� �

�Cap Beam Length������y��)��	����	��/1
#+���+�b���	��-&�����;��$���
5�2$ �*� �
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*Number of Columns��y������C������/1
#+	���
3
)���=����%��1�$)���%������2$ ���)��	����	�*�� �

Cap Beam Section����y������������������������������	���;���$��-`8)������������($6)�'�A#1���2$ �*� �

Distance From Left End Of Cap Beam�y��!+����	�,���6
5�-3�)�\�	T"�,9)�{X�

�$��	����/1
#+���+b���)��2$ �*� �

Include Vertical Diaphragm�y� �>"�7���'�A#1��������,��-`8)���/#1�����
!��2"��:������#(��

��
���)*� �

Bent Connects To y����7��	���!(&���%�$����E���,9)	��-&����-`8)�����,��������$����;���

�/1
#+���+b�����)�zA0)��
�*� �

Link/Support Property�y��������-�`8)	��-�&������%�$����E����,9)����r
��)�������4�3	��2$c �

��������������������$"��)�4	
;�� �>"�7�������/1
#+��b�����;��$�����,�*���������4��!$c ��7����,��&����2$%�
A��"�

�
��=�Q1����� �>"����Properties�Define > Link/Support����K#+��������=�1������'��A#1���	��

������)2$��� *������� �>"�4	
���;�7������$u	� User Definition���������������������������������������������������!(���&�������������������C:��	

Bent Support �User�)�2$c ���	�������4�3	���2$ �*����������#A�+��������"���$.��@���C���������$1�"�

�=
�C)�������/1��
|1�,l)����!(�&���4	
;�7��	�Release Type�� �>"������ Partial Fixity ��	

��#A+���'�A#1����"��$.��)��	����#A+������7#�����c1	������	�2$ �*� �

���������������	���7$� j!%����/1
#�+���$"	��&�,9)���D�K�	��2$c �������������
�!1�zA0�)��������%�������4��3	�


#+��������$����!�����	Modify /Show Column Data����Q ��FGh�	���)����!1�2$ ���*� �

� �

� �
���Q �FGh�� �
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�Column Data�y,)����/1
#+����r
��)�4��d5��� �

-`8)���,;�
:��D�K�	���������4�3	����d��	��
#+��	����/1�����)���	����!(&�7���	���
�*� �

Distance�y���$C&
)������������;���$��{X���/#1�����/1
#+����r
��)������1��$)����%��������������	����!(�&�7����	����

�
���)*� �

Height�y��D�K�	����������������������������/1��������1
���,E�#)���$���b�����!(�&�����
#�+�D������`81�7����7$�������
#+�����

�)���$"�����1���
��*� �

Angle�y�������	��������	�!����9)�	
9)�7$��H���,���6
5	
9)���
#+��	����3��������%����8��od���/

�)��	�����l)��)d���������+��
�*� �

Base Support�y$.���������3	�����r
��)�4�EA0)�)��	����	�
#+��%���"���2$ �*� �

� �

�+�3��B
��:=>���
�	������234��

������	��

Add New Variation �>�Parametric Variations�>��Bridge����������Q ��FGZ�������!1����

�
���)*� �

� �
���Q �FGZ� �
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����!�����	�����$�������Q ��7���	�Quick Start������Q �FG�FM�	������!1������)�$� �2�*���A#1�������'�

��=����%��.������
3
)���/���������$��������	������!��Ok�����������������	�������r
���)����Q �����4�E�A0)

���������r
��)-`8)��	����)����!1��2$ ��*�������l)�	
5�������������������$������� �>"���	Parabolic-Linear�

���Q �FGFF��
���)��%�x*�� �

� �

� �
��Q �FGFM� �

� �

� �
���Q �FGFF� �
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 ��

����Q ��7���	������D�K�	���������
5�5�8)��g�:�V$��-����	��8)����������+�������#:�"��c1�	��*�������8)����+�

����#�(1	��8)�����)������ �*���
���)�4��d5��7����$$]�������� �>"�������K#+������	������Modify�� �

����q�
C��*� �

����2$%�
A���"�2$ ���)�,!������4	
;����2$ .1����K#+��g�:�V$��-5�8)*� �

F* )�������	���
A6��=�1�����	���-`82$ ���)* 

H* ������	�����$���($6�%��	�!��%���"���2$ ���)���C:��	�������"�	�
1*� 

I* ���!(�&��	�Segment Type and Point Type…����������'��A#1���	�-�`8)�4���$]��D
�1���

�)�2$ �*�� �>"���l)�7���	��point and initial slope�Parabola End������)�* 

[* ��!(&�	�Distance�-`8)��
5��)��	����	��$]#)�2$ �*����l)�7�������piHv�������)��#) 

p* ���!(�&�	� Dim Change������)��	����	���c1��	
�)�D��K�	���2$� �*�������l)�7����������piF���#)����������

�)�����*�� 

L* �!���,���)�7���=�!�������C� Insert Below ��	2$1���)��$�* 

v* ������������	�=
��+�����"�	�
��1����%�����"�����%��	�!�����(��$6���	�������$���2$�� �����)�����C:����������������

��!(&	� Distance����������l)�7���	������	���C���`81��
5piIM���	����+��#)�2$� ���)�*

��!(&�	�Dim Change ����!%�����piF����!�����	���������	����	�#)Modify���$�

2$1���)* ��Q ��,.�������2$%��=�Q1���+	���	�2$+���,���)��"�FGFH�
�����!1�* 

h* �����������$�����!�����	OK�������Q �����&����	����������������!�����	�����3�-�`8)�@���C����������#(��

Add New Variation�2$1���)��$�* 

Z* ����	���
�A6��=��1�������&��6���� 1�)���������	�����!(�&�	���  Dim Changepi�F���	���#)���

�	�������!�����	 Modify���$��)�2$1�* 

FM* �!(&�	�***�Segment Type and Point Type���������	�-`8)����
 .��4��$$]��D
1��

��
5I�)�'�A#1����#)���� �>"�� C��2$ �Linear��!(&	����Distance ����I	�����#)� 

  Dim Change ����piF��)��	����	�#)�2$ �*� �

FF* ������	�������C��4��d5�����	���!Insert Below��2$1���)��$��* 

FH* ��!(��&�	�Segment Type and Point Type���������������4����$$]��D
��1������r
����)���� �>"�

�� C��-`8)point and final slope�Parabola End�)�'�A#1���	���2$ �* 

FI* ��!(&�	�  Distance piIM���#)�	��Dim Change ������)��	����	��K;���2$ ������	

��!��Insert Below����$�2$1���)�*��������Q ��,.��������+	��2$+���,���)��"�FG�FI�

�
�����!1�����*����%��!��OK�2$1���)��$���	* 
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Use Equal Horizontal and Vertical Scales in Sketch� �
�
���%�
���(.������2$+���,.���8:������
!��}�$8)�� �>"�7���������C:���*� �

� �

�C	6
<��B
��:=>���
�	������234� �
	
#+���yBridge > Bridge Objects > Modify/Show Bridge Object    �� �

��Q ����
���)����!1����������������$�����	Modify /Show Spans������Q ��FGF[�	������!1������

��)2$ �*� �

� �
���Q �FGF[� �

� �

������	�����$�������%�	�
1�����1�%�������������������C:��	��k���������
�����)�����!1������~�1	������f���	����!����

Modify/Show Section Variation Along Selected Span…�������Q ������������$�������

FGFp��
�����!1��*������3
������4��$$]��\8:��. ��)�A?����	����	����2���������r
���)�	�
�1����Total 

Depth�������'�A#1���	�-`8)�=�1���!���OK����2$1���)��$���	�*����l)�7���	�������#������1�%�Span1��������C:��	�

������$�������������������	�!��****�Modify/Show���Q ��FG�Fp��	�������!1�2$ ���)�*������Q ��7���	����

��!(&Total Depth��=��1�PVAR1���	�����'��A#1����	�����!���OK�����2$�1����)���$�* ��	���	�����

���Q �FGF[��1�%��Span2�����
!1���C:��	���	���!��� Modify/Show …�����Q �	���������$��

�=�1��������!1PVAR2���	��!(&���Total Depth�2$ ���)�'�A#1��* 
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#��+����Bridge Objects �>�Bridge������!��Add New Bridge Object��	�����$�

��$1>��Q �����FGFL�
�����!1�*� �

��!(�&�	��   Define Bridge Object Reference Line�=�b�4���d5���	����������2$�+���

�.���r
`�����r
��)���	� �����1�$)���%�����,��)��	���2$ ���*� �

� �

Layout Line Namey����������)��
�&��=
�C)�g�:�V$������	��.���r
`��=�1�� �>"�7���	��2$ �*� �

Station y�����������������������������-3�)�r
`��4�E#A)��?����)��	����	���2$ �*� �

��Insert Above�y������������������ �>"�7������4�E#A)���������3�-�3�)�r
`�������%�������,�9)��1��$)������

�)��	���� �����)����"*� �

: Modify   ������������������������td;����q�
C�,����%������4�E#A)� �>"�7���������$"��)�4	
;*� �

Span Label��y����������������R(X�������{�X��!�+����,����	�� �������7$6������1������=�span start�����

�����1�$)���%��1�%����������1��$)����%�����������,E#)�����������/)�1����***span1,span2,span3,���������%���1�%����

�	� �������7��������,E#)��=�1����span to end���1
���)��:�C)*� �
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  Bridge Object Span Type  �y���	���������������(�$6��	�
�1�7���������%��� �>"���
�3
)����������������

����)��y� �

� �

Start Abutment�y��������1�%��7$6���D����,9),����)�'�A#1��� �>"�7�����
��*� �

Span to Bent�y���������1�%���%�,E#)��1�$)���%����������������
�������� �>"�7����'�A#1�����"*� �

Span to Abutment��y�1�%��%��
��2#���	� ����%����������������� �>"�7����'�A#1��
���)*� �

���������������� �

� �
���Q �FGFL� �

� �

Show Bridge Object Assignments�y����������,�����+� %�����r
���)�4�E�A0)��!(�&�7����	�����������

�k-`8)�����d��	��,����/%��"��$.���	����>$)����������������$ ��V$�������r
��)�4�!$c ��*****�f�	����	�����

�)�2$ �*� �
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���!(&�7���4��d5������	���,���)������)�����4	
;��*� �

F* ��!(&�	�Span Label�	�
1��Span Start�2$ ���)���C:�����$������	* 

H* ��!(&�	�Station�����piI���#)�	����	�������!�����Modify�2$1���)��$���	* 

I* �����������($6��Bridge Object Span Type ����� �>"Span to Bent��'��A#1���	�

2$ ���)* 

[* ��!(&�	�Span Label����4	���Span1��!(�&�	�����Item Label����4	����Bent2��	�

2$ ���)��	��* 

p* ��!(��&�	�Station �������I[�����#)�����!�����	�����������	����	Below��Insert���$����������

2$1���)* 

L* ��!(&�	�Span Label�	�
1�� Span to End 2$ ���)���C:�����$������	* 

v* ��!(&�	�Station �����piL[���#)���	����	����!�����	�����modify ��2$1���)��$�* 

� �

	����������1�%�������	����c1��	
)�,����l)�7����+��*�������������;�:�����	�� ��������7$6���p�iI�������-�3�)�\��������#)

����)��D�����6
5��
��������,���1�%��piIM��#)������������)��%�������>��)���>��)����*���-�3�)�\���4�E#A)��T6�

�������;�:�	����C�kI[�piI�piIM�f)��	����#)���
���)��1�$)������$P������	
���	
9)��!%����������*�

�����	
9)�,9)�	� ����������		�����4�E#A)I[�piIM��2$ ���)��	��*���� �

� �

����	���"	��!�����%	D1�� �

�� ��	����	����	� 

�������,���	� ����%�������?���	
9)��.$�	
;�	�����������1�,���6
5�	
9)�����
!�� ��*������	�����$����

�!��Modify/Show Abutments ….  � ���Q �����FGFL������Q �FGFv��2$ ���)��%�x��	*�� �

����Q ��7���	�������%�������	����>$)���	� ���,�����������1������	�Fp�������������+����%����8���/3�	���3	�

��2$ ���)��	��*������4	
;�7��������!(�&	��Bearing����4	����Default��������	�15G�Default�

]�$��2$%���)��$*������#�����3
������$�����>$)�������K )���)d������	����+���%����8���/3	���	���

�	��od����+���%����8���/3�)��	�����l)��)d�������
�*�����������������������������������������������������������������������������������������������������������������������������������������������

http://mcivil.ir


 ��

� �
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��1��$)���%�������	�����!��������������!�����	������$������***Bent�Modify/show �����������Q ���

FG�FL�����Q �FG�Fh��	��)����!12$ ��*���!(&�	�� Bearing�����Q ������e
:������Fp����	���3	������

�4	��������K )��)d�Default �:�?��� �)�2$ �*���� �

��

� �
���Q �FGFh� �

��!����%OK��	�2$1���)��$���Q �������%����%�x�����1
���#(�*� �

�	��G.	7�+�3��/�#0�(�����������

�	
#+����Load Cases�>�Define����Q ��FGFZ����	��)��%�x2$ ��*�7���	���Q ����r
��)�	����6��

����	��"�$ ��V$��������=�1����Prestress�����:�?����2$� ���)*�����������4	
�;�7�������������!(�&�	�Type������ �>"

Other����R���?���'��A#1���	�Self Weight Multiplier��K�;��	���	���������������������������������������������������������������������������!�����	�^<�+������

Add New Load��$���)2$1���*��"��2$%�
A����+����)�	���
��	
c )�,$�9��	��* ���������	�R���?�

����F2$ ���	���*���������� �
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#�+��Bridge >Bridge Objects > Modify/Show Bridge Object��������Q �FG�FL�

�	��%���x����)2$�� ���*����$�����������Q ��7�����	����������!�����	�*****Modify/Show Bridge 

Prestress����Q ��FGHM������
���)����!1����	�����$�����!��Add New Tendon �����Q �

FG�HF���	��)�%�x2$ ���*��%�$#%���������$ ��V$�����r
��)�4�EA0)���Q ��7���	��)��	���
��*� �

� �
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���Q �FGHM� �
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���Q �FGHF� �

� �

���!(&�	�Case�Tendon Load ����6��Prestress2$ ���)�'�A#1���	�*� �

�� �

Tendon Start Location 

:Span ���������������������1�%�����D����"�$ ��V$��,����
���)�'�A#1��*�� �

Start Location y��"�$ ��V$��,����D����,9)����	�)�'�A#1��2$ �* �7�������������($6�	�   

                          	����+����
3
)�� �>"���4*� �

• Start of Span��y��"�$ ��V$��,9)�� �>"�7���'�A#1�������	�����1�%�����#�����	
)   

                        ���$"��)�	��&��c1* 

 

• User Definitiony��������"��$ ��V$���,�9)��� �>"�7����'��A#1��������7$�$C����	����\�+
�����������

�
�������)*���
����'���A#1����� �>"�7��������"��	�
��1�Distance Along Span����������������7����	

�
�������)�*�	��	�
��1�7�����,��9)�����;�:��"���$ ��V$����D���������	������1�%��{��X��!��+��������������
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5�D
1�������������kJ�`)������(1f 

EI33 Variation �#A+�4��$$]���3	��������������������������������kEI�f���9)	
9)��
�I 

EI22 Variation �#A+�4��$$]���3	��������������������������������kEI�f���9)	
9)��
�H���� �

 

��!��Add��y��������������$���!�����	�Add���0)�
���)��:�?���C`&�7���4�EA* 

��!��Insert�y������������$��!���7�����	�����$"��)	��&���C:��C`&���,�&��C`&�7���4�EA0)*� �

��!��Modify�y��������$��!���7�����	���4��
#9)����%	�
1��C`&�4�EA0)�7$01�3��1�&
:

�
���)���C:*� �

��!��Deletey����������$�1���C`&��!���7�����	����"��)�n�������'�A#*� �

� �

� �

� �
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 ��

�-�����#A+�4��$$]��C`&����-`8)���C���R(�������$"��)�4	
;�������/#6�������.����*� �

� �

Linear M�y���������������������3	���� C�����������EI=f(a)����������������������a�+��-`8)��C��� �

Parabolic M�y����=�����3	��� C���������������2

EI=f(a     ���a�+��-`8)��C��*� �

Cubic M�y�����������=
+��3	��������� C�������
3�EI=f( a          ���a �+��-`8)��C���*� �

� �

�����1�:=>��G<	'��

	
#+����������Define > Frame Section�����Q �HGZ��
���)�%�x�*	��������!1���Q �����(�$6���

������������ $Y����� �>"�Box/Tube�Add�����2$� ����)�'��A#1��������C3�-`8)����+�������	�*�����C�

�7���'�A#1����!�����	�� �>"Add New Property  ����$�2$1���)������������Q �HG�FH1�������!�

����%�
�*���Q ��7���	����2$ ���)��	����	��c1��	
)�-`8)�4�EA0)*� �

� �

� �
���Q �HGFH� �

� �

Outside depth ��������������������������������������-`8)��3	���J!���� 

Outside Width������������������������������������������ /��-`8)��3	�� 

Flange thickness�y��������������������������������-`8)���/6����)�A?� 

:Web thickness��������������������������������������-`8)���/1�3��)�A?� �

� �
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 ��

Set Modifiers��y��!���7�����-`8)�4�EA0)��	�,$�9�������2$%���)��$$]��*� �

Section Properties��y� �>"�7���%���)��01��	�����@��C��-`8)�4�EA0)�*� �

������1�I�'0��

�-`8)�����#��+����C��,��������2$1�
���)������	�2$%��S�E#����������*������	���7������	
#+�������������������������������������

Drow>Drow Frame/Cable/Tendon� �

���������,��!������)����K#+�� �2$*������������������2$�+����	���1�%��������/ ������������K#�+��,���	��8���$;�����������

2$ ���)*��������$����!���7�����	��������Q �HGFI�������"��)�%��x*��!(�&������� Section��-�`8)���

Deck���	�2$+���,���)��'�A#1���	�2$%���)�=�Q1��*� �

 

� �
� !"��#$�%��

���U��:=>��C	6
<���

�������$����	�
��_����`������C:��	����������	�-`8)�����	
#+�����S�E#���2$%���)�*� �

Assign >Frame /Cable/Tendon >Frame section             � �
	
#+��7����������Q ����HG�Z����
����)�%��x�*����!(�&���this Property�� Find�-�`8)�PYLON��	�

��!����'�A#1�OK��	��$�2$1���)�*� �

������1������+�3���

��������3
�������. ��	�����/�������E���,9)�,���������1
��@��C����"�����*���T6�����	���c1��	
�)�
������#��

	
#+�����������'�A#1�Edit >Divide Frames                    

�����	���FM�)�2$(8���!(&��2$ �*��J��`)���Q �HGF[� �

� �
���Q �HGF[� �
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 ��

� �

Divide into������������������������� 

�����C:����� �>"�7��������C���>3����
������
��2$(8�����������'�A#1��*�2$ ���)��	��*��7��	�

���l)
�����10��
���)�2$(8�����()��!(&�*� �

Last/First Ratio�� 

4�!$(8���"����>3���#���1��1�(.���
5��������*��(1��
5��>3���#�������/#1������	�
����	���������

2$ ���)*� �

 

�5	6)$��!�?�������	���H1+.�9���L����:X���+�	����	��������;�����1����� �

� �

	
#+����Define > Link/Support Properties > Add New Property                   

      ���Q �HGFp��
���)����!1*� �

� �

� �
���Q �HGFp� �

� �

�7���	���Q �������������($6����Type �Link/Support���� �>"�Linear�����2$� ����)�'��A#1���	*�

�!(&	���Property Name���	����	���
A6��=�1���������������	����!���Fix All������	�^<�+�
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 ��

�����%��!��OK����$��)�2$1���*���2$+���������
�������������������������@���C����%���"������1
��,E#)�\��	

,������)����K#+������	
#+����2$ �*� �

Draw >Draw 2 joint Link� �
���e
:	
#+��������Q ����!(&	������
���)����  Property�������'�A#1���	�r
��)�=�1������$��	��

�6�����"��,�������	����
������	���+�$���)�2��2$� �*� %�	���P����!(�&����������2$�+���=����Drowing�  

Control  Type��� �>"� Vertical�	�2$ ��'�A#1��*���2$�+���������������%�
�������P��������	
#�+�����

Replicate������)����K#+�2$ �*�������������������������,E�#)����%�
����2$�+��������C�������)���@E�1�����������,�����

���Q ��4	
E�HGFL����%�
�*� �

*� �

���Q �HGFL� �

�Y"30�H1!��I�'0����	?��

� �

Define > Cable Section >Add New Section� �
� �

e
:	
#+�������Q ��HGFv�
���)����!1�*� �

� �
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 ��

� �
���Q �HG�Fv� �

�7��	����Q ��������	�,����`&[ �#!$#1�+��	���������2$+�������������_	���e
:���Q ������^<+���	

������`���;� ��2$+����)d��������$�������2$ ���)�2$+����	������*��2$+���U�	��������$�������#������

�����������)�
�����/#1�����
��*������������+�	��!�����	������2$+���4�$�!���������������������	�
�
)����$�

����	�2$+���4�$�!���$� ����u�����3��`81�����2*�	�����Q ��Properties Of Object�D
�1����
�����

���'�A#1���	���-`8)��������������������,���o��`.�����/�����2$�+��������C��������	
#�+������Mirror���������)����,����	�

�,$!.��)�2$ �*��	���7������,�&�����$1��N�P-Delta��	��������!���2$ ��*�	
#+������ �

Assign >Frame/Cable/Tendon >P-Delta Force� �
��Q �HGFh��
���)����!1*� �

� �
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 ��

� �
���Q �HGFh� �

� �

���!(��&�Force� Initial�4	������,����8)	��Force������$6��������$1�	����8)���	10�7�
��$1�
���$���	����������

�2$ ���)*�����!�����	�����$�����OK�2�
���)�_	���e
:���Q �����*������	������'��A#1���	���/�����=��!�

����
!1�����	
#+����)�2$ ���)�,$!.���	��*� �

� �

Edit >Replicate > Mirror� �
� �

��7��	�����Q �����	
9)����
)�	�8���9K;�
Xx��+��*����������9K;�7���4�E#A)���������C:��		
9)�7����T6�

�)��
�&�g�:�V$���	�2$ �*k�J��`)��Q ���HGFZf� �
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 �	

� �
���Q �HGFZ� �

� �

�������2��������(6�)��	�,����)�@E1��Q �����*���,)���2$+����������,����)���!�����������2$+�����/#!(&�=��������

�	
#+����������'�A#1���	�,��_���>3 Edit > Replicate > Mirror����)��	.��,�$!���2$� ����)*�

��	�����Q ���	
9)��������!1Y��	����'�A#1����)2$ �*������������
!1���%�0)����������C&���4	
�;������%�
������

�	
#�+���� View > Set Display Options����������K#�+�������	������Q �������������!1���� �>"� 

Extrude view��C:��	���2$ *�oT�������V��!1����.���r
`���	
#�+��View >Show Grid��

����K#+�2$ ���)�*	
#+��7����������)��/ ��,��
���)����!1*� �

���U��+�	����O0�;"���C	6
<���

	�������2$+��������"��%��)�'�A#1���	���"��$.���2$ �*	
#+������ �

Assign > Joint/Point >Restraints (Supports)� �
��������Q �������
���)��������c1��	
)���"��$.����	���$�2$1���)�*����$�������	���!���Ok����Q ���	����

2�� ���)*� �

�C	6
<����	#?��	���"	���	��	����O0��

���
��V��!1��6���������_	���������)���� �>" Extrude view �2$� ���)���C:��$u��	�*����!������=

�����1
��=
�C)�,����%���"�*������������������'��A#1���	��	�� �����/%�"���$.������r
���)��	� ����%���"�=�P %�7��	�

�,�&��6���,l)��	��c1��	
)���"��$.�2$%���)�S�E#���*�� �

� �

��/#�����	���H1��

	
#+�����������'�A#1���	�c1��	
)�
��� �

Assign > Assign to Group > Add New Group� �
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����Q ��HGHM����	���!1����)���2$� ��*���	
�)�7���	�����������"�����	���	�,���_�������=�� ��PYLON�����:�C)��������

�2$ ���)*�������,���	�/X�%��
���)���l)	
`����������"����	���	������$�����������:�C)��*��������C�����/1�	�

��/%��"���Q ��	�HGHM���%�0)����%�
��*� �

� �

� �
� !"��#$#&��

��

���L0�G.	7�+�3���

���	
#�+�����> Add New Case� Define > Analysis Cases����Q ��HGHF����
�����)�����!1�*�����������������������

	����!(&Name�Analysis Case�����l)	
`����
A6��=�1���� StagedCon ��2$� ����)��	����	�*�

���!(&	�Type� Analysis���,$�9��D
1��.$��#+���zA0)��	2$ ���)*��,�������������������3
�����

�����)��������,���$�9���P#(����������������	���	�����N��7�����������������1��Q�	�������	�T���"	�����������+��������������������������

���� C��,��$�9��=
��+���� �>" Nonlinear Staged Construction���)�	
��c )��2$�� �*��!(��&������������������������������������

Type �Analysis Case��� �>"�Static2$ ���)�'�A#1���	�*�� �
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 ��

� �
���Q �HGHF� �

��!(&	�Stage Definition���)��	����	��Q�	������+�������1��	�T"	���,���)� �$����2

������)�����4	
E�*� �

���"�D
1� ���	�R(������)�� �,���)� �

Pylon 3� �1 

Deck1 3� �2� �
Deck2� �3 3� �
Deck3� �3� � 4� �
Deck4� �3� �     5 

Deck5� �3 6� �
Deck6� �3 7� �
Deck7� �3� �8� �
Deck8� �3� �9� �
Deck9� �3 10� �

Deck10� �3 11� �
G� �3 12� �

G� �10� �13� �

G� �30 14� �

G� �100 15� �

	�����Q �HGHF������������!1�����!�����	Add��$������2$1���)����	��������!(&Day)fDuration����4��)

��������+������=�b��)������,���_����������R(����������	���	������2$� ����)*�����������7�������	
�c )���	��������!(�&�

Comments��User���	�,����_����������r
����)�=���1PYLON ��$�� �����)��	��2*��^<��+���!������	��

Modify2$1���)��$����*� �
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 ��

�������	����������4���d5���������������)�����r
���)����!(�&�	��� Data for Stage…���������(�$6

����������Opearation������� �>"Add Structure���'��A#1���	������!(�&��� Group �������"�=��1

����c1��	
���)������� C��PYLON�'����A#1���	������!(���&�	��Age At Add���������I���	����	���������������������

�)�2$ �*�^<+�!�����	��Add �������$��������	�������(�$6��Operation����� �>"��Load All 

in Group�����!(�&�	���'��A#1���	��Scale Factor�����%�
�A6���R���?�������������������! "	>�����

���%�=��"������3�����,$�9���	����)�2$ �*�����l)�	
5���������?�7���������RH���������)�*������	�,����)�7���

�����������2$�%����)�=��Q1�������@���C�����/%��"�����C�*�̂ ����=��!������������!(�&�	��,����)�7����Stage 

Definition��,���)������C������	�!������)�FF����	���:�C)�2$ ���)*������	����������#�6��������4���d5�������

�!(&�	��,���)�7��***�Data for Stage���^������������	����Q ��	��4��d5��7HGHF�������Q ��

����,$!.���j ��4	
;����HGHH��%�x���
���)*� �

� �

� �
���j �HGHH� �

	���Q ���!%�����������!(�&� Other Parameters�����!�����	�Show�Modify/�������������	�

� �>" Results Saved 	��&� �	������$��2$1���)�����Q �HGHI���!1���
�*�4	
;�����	���Q ��7��

���2$ ���)�,$!.���*� �
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 ��

� �
���Q �HGHI� �

� �

�	������Q �HG�HH������!�����	Show�Modify/������ �>"�����r
���)�Nonlinear Parameters ��

��$�2$1���)�������Q �HGH[�
�����!1��*� �

��Q ��7���	��������!(&Parameters�Geometric Nonlinearity���� �>"P-Delta Plus 

 Large Displacements ��)���C:��	��2$ �*� �

� �

 
���Q �HGH[� �

%/�����L0��

	
#��+������Analyze > Run Analysis ����������Q �������!1����
�������)�,�������6�����������	

���%	�Load ��StagedCon ���)�,$�9��� �$2*�,$�9���6��MODAL ���	���2$� ����)���C:��$u*�
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 ��

������7����	
c )�������C:������
!1����,$�9���6���7����������������~�1	����������)�,��������������
��*������!�����	�

Case�Run/Do Not�������$�����^<+���!�����	�Run Now����$�2$1���)����,�$�9�����)�����

�
�*� �

�����	��+#L#����/�	$�����(#0��	���H1��

��	
#+����Display >Show Forces /Stresses��� �

�����Q ��Member Force  Diagram for Frames ����
�����)�����!1����������Q ��7����	�������������

�����$����!�����	drop down���c1��	
)	����6����2$ ���)�'�A#1���	*� �

� �

Component� �
�����������������$1����������0�j$����0�!�����%�P 6��
�!1�zA0�)����r
��)�����
3
)���%�� �>"����.�

������)�@�#A)���%	
9)����#)�	���	
9)�2$ ���)�'�A#1���	*� �

� �

Scaling 

���c1��	
)�}�$8)�����)�1���}�$8)���2$ ���)����K#+*� �

� �

Option 

��� �>"������C:�����!(&�7���	�Fill Diagram�������V���!1��P1	�4	
;�����#+�
�	��� 9 )��

���
�����)*�������/0� �������������8)�V���!1������������ �>"Show Values on Diagram�����C:��	����������

2$ ���)*� �

� �

���+�	�,��V)"�	0�+4�<�("	D�	��� �

� �

Display > Show Plot Functions� �
� �

�e
:	
#+���������
�����)�����!1�������Q ������������������$�����!�����	�Define Plot Function��

�����Q ����P����	�������!1����)�2$� ��*	���!(�&��to Add�� Choose Function Type�������(�$6��

������������� �>"�� Add Joint Disps/Forces'�A#1���	���2$� ���)�*��^<�+���!%�	��������Q �

����	�!���Add Plot Function���$�2$1���)�*������Q �HGHp�
�����!1�*� �

� �

� �

Joint ID2$ ���)��	����	�c1��	
)���"��	�!��������������������������������������*�� �
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 ��

Vector Type2$ ���)�'�A#1���	�������%�� �>"�����.�����������������������������*� �

Abs Displ�����������������������J�`)��.)��$$]����������� 

Displ�����������������������������������������.)��$$]��� 

Abs VelJ�`)����+������������������������������������ 

�Vel����������������������������������+������������� 

Abs AccelJ�`)�'�#��������������������������������� 

Accel�������������������������������������'�#����� 

Reaction,!C6��^.����������������������������������� 

 

� �
���Q �HGHp� �

� �

Component 

	�������#+�	kU���8#1����R�	���f 

���%��!��OK��	���$��2$1���)��������Q �� �

���������������������������������Plot Function Trace Display Definition� �
2$+���*�7��	�����Q ����!(&���List of Functions�����!�����	���������'�A#1���	��c1��	
)���"��
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Horizontal Plot Function�� �>"��������������������������Time�)�'�A#1���	��2$ �* 

Axis Range Override)�@��C���1�)������9)���������������������������������)�'�A#1���	�� 9 �2$ �*�� �

 

�������
��R+� )�4�!$c ����+�����!�����	Display������$����2$�1����)*������������Q ��	����7�������HGHL�������������!1��

�
���)*� �

� �

 
���Q �HGHL� �

� �

�+�	�,��V)"�	0�+4�<�("	D���H1���	?��

� �

Display > Show Plot Functions� �
� �

�e
:	
#+���������Q ���
���)����!1����!(�&����� Vertical Function���oT����	���/��A#1������+����

�2$ ���)*��7���������	
c )�����������'��A#1���	���c1��	
)�� �>"������	��������!Remove�������$������2$�1����)�����


��oT�1�*^<+���!�����	�Define Plot Function����$�2$1���)*� �

�������!1������Q ����!(&�����P��to Add�Choose Function Type������($6��	�0�������

����� �>" Add Frame Forces'���A#1���	�2$�� �����)�*����!�����	�Add Plot Function��������

��$��2$1���)������Q �HGHI���
�����!1*�	��7�����Q ���	�!����
�����	����	�,�����!�����	 OK 

�����$����������������:�C)�������%
��������!�����	���P��Add Plot Function������$���2$�1����)*�����

���!���%�OK��	���$��)2$1�����������������Q �Plot Function Trace Display� Definition��
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2$+��*�7��	�����Q ���!(&��� List of Functions��%�
���������!�����	���'��A#1���	���c1��	
)�

Add���$�2$1���)�*� �

� �

Horizontal Plot Function�� �>"����������������������Time�)�'�A#1���	��2$ �* 

Axis Range Override�)�'�A#1���	�� 9 )�@��C���1�)������9)�������������������������������2$ �*�� �

 

����
��R+� )�4�!$c ����+���!�����	Display���$��2$1���)������Q �HG�Hv��
�����!1*� �

� �

 
���Q �HGHv� �

� �

�+�	�,��V)"�	0�+4�<�("	D���	���H1��+$D<��

��

Display > Show Plot Functions� �
� �

�e
:�	
#+����������Q �����!1����!(�&������
���)Vertical Function����oT����	���/��A#1������+������

�2$ ���)*����7��������	
c )�����������'��A#1���	���c1��	
�)�� �>"�������!�����	Remove������$������)�2$�1�*������


��oT�1�*^<+���!�����	�Define Plot Function���$�����������������!1��������Q �����P��

���!(&���to Add�Choose Function Type����������������($6������ �>"Add Frame 

Forces�'��A#1���	����2$� ����)�*����!�����	��Add Plot Function�������$���2$�1����)��*������Q ��	�

����!1�����	�!��
�����	����	�,�������2$ ���)�*�������!(�&Component��Moment 3-3����	

�)���C:�2$ �*��!�����	 OK �$�2$1���)�*��@��C��������
������P��������!�����	�Add Plot 
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Function�������$����������������C���%������R$����7$!%���
���������	�,����)�7����=��Q1����)��2$�%��*�����Q �

Plot Function  Trace Display Definition�������
�����)��%��x�*	���7�������Q �������!(�&����

List of Functions��%�
�������!�����	��������'�A#1���	��c1��	
)Add��$���2$1���)*� �

� �

Horizontal Plot Function�� �>"��������������Time�)�'�A#1���	��2$ �* 

Axis Range Override���������������������)�'�A#1���	�� 9 )�@��C���1�)������9)��2$ �*�� �

 

����
��R+� )�4�!$c ����+���!�����	Display��$�����Q ����2$1���)HG�Hh��
�����!1*� �

� �

 
��Q �HGHh� �

� �

���_	���������Q ��7����������!�����	�OK�����	����Q �����!1�!�����	������Done�������$��

2$1���)*� �

������n�9#)���%	���������	��,��,$�9�������������,����	�
$)���������.$:��"�����E����%�0)�����,����)�

� #��,�����r
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R�3������,	-./���

 
�R�3�����5	6)$���

��������	���c1��	
)�,����l)�7��	��+����1�%���+�*�����1�%������	� �����HMM��#)���������1�$)��1�%����LMM������#)��

�������)*����,����"	
��L����#)��D�K�	���,�����1�$)�_�����vM�����)�#)����*������+� %���Q�����������,�������,����)�

�	���2$%���)�=�Q1���*�	
#�+��  File > New Model From Template�	���������3�����������	��

�� C�����$c1��!�����$�����2$1���)����Q �IGF���"��%�x�*� �

� �
���Q �IGF� �

�	����Q ���	�����%�x��,��!���Cable Bridges����$��$1>��*����Q �IGH
�����!1��*� �

http://mcivil.ir


 ��

� �
���Q �IGH� �

�������$���!�����	�Parametic Definition�����Q �IGI����	��)����!1�2$ �*� �
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L1**********************************{X��!+��1�%���
5�� �

L2**********************************,���1�$)��1�%���
5� �

L3**********************************%���
5��+�	��!+��1� �

S*************************************�,����1�$)�����1�%��>��)�	����;��,�����������7$����;�:�7��#!��� �

W*****************************�*****,�������g��� �

H1**********************************���������������_���D�K�	�� �

H2**********************************��;��,������$"�	��&�,9)�����������_���D�K�	�� �

N1�*********************************�%>������$"	��&������{X��!+��1�%��4�!$(8�����C�� �

N2**********************************��%>������$"�	��&�������`+���1�%��4�!$(8�����C�� �

N3**********************************��!+��1�%��4�!$(8�����C���+�	�%>������$"	��&������ �

� �

������������c1��	
�)�,����������	�4��d5��7�������J���`)�������Q �IGI������)���	����2$� �*���������������$�������!�����	��������

OK��,����)����Q ��J��`)I�G[�)����!1����
�*��!(&�	�� Section  Properties��%�����
���

��:�C)��	�4��K#)�-`8)���2$ ���)�*���	�'�A#1�-5�8)�-5�8)��$$]�����/1���2$�����#���1�,.0)�*�� �

�� �

� �
���Q �IG[� �

� �

���g�:�V$����)�	�����������-`8)�����$������	������-`8)�W18*35��2������:�C)�*���������������1�%������3
���

,������������4	
;�����	����)���������)�2$ �*����������7�����Q����������������D��K�	�������1������������$�������<����

������,��)���2Y�&�������2$+���������������$"��)�4	
;��*�������#�6�����	�������2$+������Q �������P��������Sap����

��������<��c1��	
)���Q ������6�)�������������(������=�Q1���
���)��	�*� �

��$������	�������8:��	
#+��Select > Frame Sections ������'�A#1����
3
)��($6������8)�-5��

-`8) ������	� �'�A#1�2$ ���)�*��	
#+���� Edit >Replicate���Q ������
���)��%�x*���J���`)����

����Q �IGp���	�����)�,$!.��2$ �*���7��	����Q ���������	������D�K�	�����I�������#:�"�c1�	���#)����������!(�&�	�

dz7��������;�:��	���
���)*� �
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� �
���Q �IGp� �

���2$+���������
��������2Y�&�������
������������	
#�+������^<+�������2+	��	�Replicate�����������C�������	���

�����,;�
:������=�bp�������2$ ���)�	��.��2%�����#)��*�������	���.�������)�	���$ ���3
�������
���	�����#�+�	���_����

,�������%��J�` )�2��1
01�*���_���
���7$ j!%����������2$(8��������������%�
��������E���,9)�	�����
���*���������

�-5�8)�7������($6�����-5�8)���
3
)��-`8)������S�E#���2$+���=�P %��	��c1��	
)������)���2$%����������)����
��

�����������C��,���)�	���������'�A#1���	��%�
A6��-`8)���������3�-`8)���	�����7���������������%
������7�>P���3

!1�
*��2$�+��������������%�
��������`&����,��!�����������	
#�+��4	����������������Drow>Drow 

Frame/Cable/Tendon�����������
��������������	
#�+������	��$8����2$+����	���`&�Replicate����������C�������

������=�b����,;�
:�p������)�	��.��2%�����#)�2$ �*�������������������	�0�:����%��$1�\�8:����������������. ���������3
����

��!9���	��00�����  ���)�,*�����oT��������T6�����8#1�������%
���7�����E���,9)�	���P 6���)��!��������%
���

�	
#+������������'�A#1���	�2Y�&���,��)� �

� �

�Assign > Frame /Cable/Tendon  >Releases /partial Fixity…� �
� �

����Q �IGL��	�����!1�,$!.������)�2$ �*��!(&�����+���#/���/1��'�A#1�������Select��K#�+����2$� ����*�

����-`8)�=�1�����%�"����������%�
�����2Y�&���,��)�����/1����	������������������	���&��	��	�
��
)���������$�����	

�!������+�	��	�
�
)����Q �������	��/1��4�EA0)��%�x���)�2$ *�������Q ��7���	�������� �>"Assignment��

'�A#1���	�������	�����Q ��������!1���4�EA0)-`8)�2$ ���)���%�0)��	*�� �
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� �
���Q �IGL� �

,���)�7���=�Q1������C������)�,��4	
;������Q �IGv���
���)�������01*������������ �

� �
���Q �IGv� �

�����������1���������'�A#1���	������2Y�&���,��)���%�
���=�!��/�����������,���g������/3�	��=�b�����C�������	�����<���������

�)�2$ �*���������"	
���g�������3
�����L���#)�����g����/3�	���,���������I������2$ ���)����K#+�����*���7����#�6��

�����+�����(6�)�B�96����\8:������	���1�����+�9)����� 3�*�	�������/6��)����Q�������������X
�����)����a	>�����

����	
#+��������K#+�Replicate���+���N
)�	�$(���*�������/1����E�K)�4b�E����������������)���Q���	������3
�

�$ �*���������������4b�E���,9)�	��@�������� ��2$(8�������$1��"�*�=�!����%
��������`���������	�@������/6��

��'���A#1�������	
#��+��Divide Areas�Edit >����������Q ��	�������!1���)�2$�� ����������Q ����	���

��� �>"Divide Area Using Cookie cut Based On Selected Point Objects�	��	��

�����Q ��������C:��������!����C���OK��	��$���)�2$1��*����	
#+��7�������@��������-5��8��,�9)�	��

�)�2$(8���%�$���
�*� �

�� �

W.	6��5	6)$��+�3���������������������������������������������������������������������������������������������������������������������

���b
�:�s6�E)�4�EA0)��:�C)�������	
#�+��Define > Material �������3���	����������	������Q �

1�������!�� �>"�Steel����'�A#1���	��!�����	�Modify/Show Material����$������������Q �

��������!1�)�,$!.���	�2$ �*�k�J��`)���Q �IGh�f�� �
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� !"��%$'��

��

Define > Materials� �
���e
:�	
#+�����3������������Q ���!(&�������
���)����!1Materials����� #��s6�E)�����4	������� C�

Conc:��	�������������C������$����!�����	�Modify/Show Material  ����	�������Q ���4��!$c �����

2�
�������)*��!(��&�7����	�����U>����N�������r
����)�R�����?������P#:	��������	�7#����������$����	�����������������

���!������Time Dependent Properties���������Q ����������%��x����=��Q1�����2$�%����)*�	������Q �����

Data �Property��Material���	
)�4�EA0)��
���)��c1���$$]���	��V$���4	
E������������g��:

�
!1��
�&* � �

� �

���������� �
���Q �IGZ��� �

����������������������������������������������������������������������������������������������������������������������������������������������������

	����Q �IG�Z����U>��N�P#:	�����	���7#���
���)*� �
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Relative Humidity���������������������������
5	��;	�������(1��N�����r
��)�U>��� 

Notional Size,h������������������������������������C����r
��)��?�:��U>��N� 

Shrinkage Coefficient,Bsc��R��?���������������$N��P#:	���7#�� 

Shrinkage Start Age (days)D����7+������������P#:	�����	�R(����7#��� �

� �

+L='�T	#1�5	6)$��+�3���

Define >Area Sections >Add New Section� �
�	
#+�������e
:��Q ��������)����!1��
���������!(�&	�Bending����������!(�&	�����0�!�	�#:	��)�A�?

Membrane�	�����0u�	�#:	��)�A?���)��	���2$ �*�� �

� �

+=<�T	#1�:9	>��+�3���

��������;�E#����;� �����%�
������)����4	
;������K3���������)���:�C)��0��1����1
���*����7�������������	
�c )���������

�����
�������)CD������������1�����-5���8)���������P�������%����)����1�7$�����-5���8)����������K#��+�*��	
#��+�������������

Define > Frame Section������!1������Q �������
���)�������($6������b������� �>"���	�

Import Double Angle �����$���2$�1����)�*�CD�����'��A#1���	�-5��8)����������	��������!1����Q �

������@�#A)�-5�8)��($6���������2$� ����)�'�A#1���	��c1���	
)�*������'��A#1���������-5��8)�������!��Ctrl�����P1��	�

����#������	�����-5�8)�=�1���$��2$1���)�*����-5��8)�'�A#1�����^���������!�����	�OK��������$�����������������Q �

�
���#(�*	���
��'�A#1���($6������:�?��������	�	�
1�� $������
0����� �>"���	�Add Auto 

Select List���$�2$1���)*�	���Q ����������!1�$0�������	�
��
)���
�)�-5��8)���	����c1��	����� C��

2LB��($6�	�����List of Sections�����1	���	���&�*)���8��'��A#1���	�-5���������������������$����	�

��!��Add����-5��8)�7��������	����
��'��A#1���(�$6����kAuto Section�f���:��?����)��1
���*�	��	�
�1�

���0������Auto Section Name ����=��1��Truss��	����	���������̂ <�+����	�����!���OK����$������

)��2$1���*����4	
;����,�����0�1�-5�8)�2LB10-E3.0�������1
����)�������01�*�������
��3������LB����0�1�

�����R(�����0�1��	�!���� %��#!$#1�+�)�����*�����o��������	�����E����������0��������0����;�:��� %���01�

��+���0�1�����#6��	���������� �(j��2%������0�1������*���������������)��K;�����7���*��������'��A#1�������������%�



:&�1���������1�#9�������!(&���select���1�����-5�8)��!(&�����������'�A#1���	�-`8)�D
1��������K3

����	�!���0�1Fp������;�:����HiF��#!$#1�+�������'�A#1���	�2%��)�2$ ��*��������
������2Y�&�����`&���%�������K3

�����	�!������0�1FH����0������0����;�:������HiF�#!$#1�+�����)�S�E#���2$%�*�����+����������>�$1��%
�����

2$%���)�=�Q1���	�,���)�7��*� �

� �
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����=>��T	#1�5	6)$��C	6
<���

�%���"��$.��S�E#��� �
	
c )�7����������������)���/#1����#��	��-&�������`81�;� ������'�A#1���	���	
#+�� �

Assign >Joint Restraints���Q �����	�����)��%�x2$ �����������������'��A#1���	����"���$.��D
�1���

��	�����!OK��$��)��2$1�*� �

+L='T	#1�5	6)$��C	6
<���

����$���������	����%�
��������9`+�	
#+�����Select > Select > Area Section �/1����� �

��'�A#1���	�����	
#+���Assign  > Area > Section����Q ���2$ ���)����!1��	�������������!(�&�

   Sections ���r
��)�=�1
������	��9`+���'�A#1���!��OK��	��$�2$1���)�*��

��

�+�3����+�	���U��B
��:=>���

Define >Frame Section 

���:�C)_���-`8)�=�Q1��������,���!(&�� 1�!%��
���)�*����������,���VA��	��-`8)�7����:�C)�,���)

�+����)�*� �

Y"30�H1�!��I�'0����	?�� �

Define > Cable Section >Add New Section� �

:	
#+�����e���Q �IG�FM�
���)����!1*� �

� �

� �
���Q �IGFM� �
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�7��	���Q ���,����`&�>������	�L �#!$#1�+�����	����;��,�����`&[M���#!$#1��+�����2$� ����)���:�C)*�����N�

�����$1P-Delta���
���)���!����/�����	����������	
#+��������!���)����"*� �

Assign >Frame/Cable/Tendon >P-Delta Force             � �
��	
#+��7�����������Q �����������������V�A�	�����
�����)�����!1��Force�Initial������4	�����,���8)	���Force�������

�8)	����$6������$1�	�	���l)�7��	����p�7���+����	��2$ ���)*� �

� �

�����L0�G.	7�+�3���

�	
#+����> Add New Case� Define > Analysis Cases��������!1�������Q ����������
�����)��������������������������

��!(&	�Name�Analysis Case���
A6��=�1���������l)	
`� StagedCon �2$� ���)��	����	�*�

�����!(&	�Type�Analysis���,$�9��$��#+��.���	�������2$� ����)�'��A#1��*������,���������J��C)��������������3
�����

,��$�9���P#(������������������1��Q�	������	�T��"	����������+����)��������,��$�9��=
��+���� �>"��C����� 

Nonlinear Staged Construction��'�A#1���	���������������!(�&Type �Analysis Case�

����� �>"Static������)�'�A#1���	���2$� �*����,����)���������7$� X�4�E�A0)���:�C)�9����$����J���`)�����,����!(�&������

������������)�=�Q1���
�*�����������������,��	������+��7���4��K���/ �7$:�5�%��������1�$)�,����4��$�!���

�����+��D������������������)��)���*����)��	����J�C)�,������������+�,���)���1�%��\+�����,���D��������������

��%����������	� ����
���)�2#���*���������%�
����� �����"�	����|()�7���,$�9����������������
��B�96�*��,����)

���r
��)��,$�9�����%��$1���%�0)������5�%�
������,��J��`)���������������)*� �


������,��7������������$ ���3�����6������2����1�=�Q1���	�n�9#)��	�T"	���,$�9���*��������������	��,���,$�9������

�n�9#)���%	����������,�����	�
$)���������.$:��"�����E����%�0)������,����)������������	��� #��,�������r
���)

2$ ���)�	��.�*� �

��

��

��

��

��

��

��

��

��

��
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���	�!��*���(�)� 

 

� �
%/��5	6)$���

��1�%�����4	
;����,��+��������
5��I�iFh�#)�������)��*� �

��"	
���g��,��L�iI��#)��������)*� �

,��������D�K�	���LiI�#)�������)�*� �

���.`�u�o�`.��	��,����"��$.��������)���EK)�P���o�5�	�*� �

-5��8)��%�
���,���������)��0�1��K3�D
1����*� �

?��������"	
���� #�������)�A�FH���#)��#1�+�������)*� �

��1��	���������,��@�����������	�����%	������8)2m� 500Kg /����)�	���������2m�100Kg /�

������)*� �

� �

� �

%/���'/#��I�'0��

FG	
#+��File > New model�$ ����3���	�*��	��. �������!������$��$1>�*� �

7��	���Q �����������)�����+�������2$1�
���)�����!(�&2D Trusses������3D Trusses��������Grid 

only2$ �����K#+��*� �

���,�����(6�)��������!(&Grid only�)����K#+���2$ �*������������$������ �>"�7������	��������Q ��

�����!1��
���)*��������(&�7��	���	��.���r
`�����r
��)�4�EA0)������2$ ���)��	����!*�������	
�)����l)������

�c1����"��)��	�������4	
E��4��d5�*� �
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• Number of Grid Lines 

 

F* X direction�/3�	���.���r
`�����C���������������(11) x 2$ ���)��	����	��* 

H* Y direction���/3�	���.���r
`�����C���������������yk�2�f�2$ ���)��	����	* 

I* Z direction�����������/3�	���.���r
`�����C������ ( 2) Z2$ ���)��	����	* 

 

• Grid Spacing 

 

2$ ���)��	���	
9)��+��%�������	��.���r
`���(.��,;�
:��!(&�7���	�*�/3�	��x���hiF ���#)

��/3�	��y���h�iI���#)����/3�	�z���hiI��������2$� ����)��	����	���#)�*��������������.����r
�`���������$1�4	
�;	��

���()�1�,;�
:����	��� �>"Edit grid���$�2$1���)*��	���������!1���Q ��4��d5�����	���c1��	
�)�

2$ ���)��	���*� �

�������������4���d5��7����������	��������C����?�����l)���������������������$��������!�����	�OK�������.����r
�`��

���Q ��4	
E�[GF�
���)����!1�*� �

� �

� �
���Q �[GF� �

��������`���;� ��2$+����)d����	����������$����������������������	
#�+��4	���������K#+�����2$�+�����6��

'�A#1���	�)��2$ �*�����������������������������������������Drow > Drow Frame/Cable/Tendon������������������������������������������������
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�

 �2$+���U�	�������$���������)�
�����/#1�����
������#������*�����������������������$�!�������2$�+���4

�+�	��!�����	����	�
�
)�$���������3��`81�����	�2$+���4�$�!���$ ����u��2*�� �

���������1�#9�
��������#����	������	
9)��/3�	��X����7$6����������,���g��������#)��	��
�����	�����	
�9)���/3

Y��	�)�2$+���2$ �*	
#+��������K#+�����Replicate ��
���	�����2$+��'�A#1���������C����p��	
)���

�����;�:��LiI���2%����#)����)�	��.��2$ �*���7$!%������%�
����������	
�9)��/3�	��	���7����'�A#1���	��1�#9�Z��

�)	��.��2$ �*�������������2$� ����)�2$�+���R$����7$!%�����	������2Y�&���%�
��*������������6���������_	�����������

Draw������!������	�Pointer����$���2$1���)�*�����2$+���,���)��"�����%�
��������=��Q1���+	���	�2$�%�m

������/1�	�����Q �[GH����!1��)���
��*��������������������0)���.������,.��7�������$+	��������1�	��������$��S���

� ���!1*��#0$���.����#(����	�����)�J$&����-��+�2$+����������	����$&d�����*� �

� �

� �
���Q �[GH� �

���������2$� ���)�'�A#1���	�������1�&
:���1�#9���6
5���%
��*������C����������C:���6���������. ���������1�)�	����*�������

����	
#+�y� �

Assign >Frame/Cable/Tendon >Automatic Frame Mesh.            � �
��2$ ���)����!1��	������Q ���Q ����	�������� �>"at Intersection with Other Frames��	�

�������C:��^<+��!���OK��	���$�2$1���)*� �

� �
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� �

� �

�������,���4���!����G2-���	���H1	�<��

���	
�c )�7�����������%�
�����d��	��,���)��0=Y@z- x� 3.6=Y@z-x�	������������������'��A#1��

	
#+�� �

Assign >Frame/Cable/Tendon >Releasess/Partial Fixity          � �
������0)���Q �[GI����2$ ���)����!1��	�*�������%
�����EK)���E�������3
�������������"�������oT�������r
���)�� �>

���-`8)��
&	
9)��
���0!��P 6����#��	������/#1��
�������2$ ���)���C:��	�*����������E����,�9)	��	����7�������

�%�
��������!1���8#1���0!���P 6��$%�*� �

� �
���Q �[GI� �

+L='�T	#1�I�'0��

��������9`+��;� ��2$+����!�����	���������$����������������$������9`+�;� ����%���
"���	�����7����

� ����)�2$+����	�;�2$ �*������������	�7$C)��/3����	��������9`+��;� ��2$+���������=�!���r�81����
"����

���9`+�;� ����$��2$1>*���������$������!�����	���������6����_	���2$+�������2�
�����)�*���7�����,����)

2$+���������4	
;���������)*� �

F* �9`+��;� ��2$+����!�����	��������$��$1>�* 

H* �	
#+�Snap to points and Grids Intersections���	����C:�$ �* 

I* ����`81�	�kx=0���y=0�f����$��$1��*���������������r��81�	������+����%�����8����/3�	����������^<+�

kx=0��y=3.6�f��kx=18.3��y=3.6�f��kx=18.3��y=0��f���$��$1>�*� 

[* 2$+����6���������_	����������!�����	�Pointer�����$��$1�* 
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p* ���%�0)�������#/���̀ �+���;� ������!�����	������9 Set Display Option �������$���

�	�����Q �������������!1����� �>"Fill object������$ �����C:��	*���4	
�;��������)�����Q ���[G�[���

����!1����%�
�*� 

� �

��@������
X����X	�<.��4	
E���2$+������*���� ��2$(8����������=�!������%�
������`������	�@����/6��

��'���A#1�������	
#��+��Divide Areas�Edit >��������!1��	��������Q �����)�2$�� ����������������������Q �����	���

��� �>" Divide Area Using Cookie cut Based On Selected Point Objects ��	�

����C:����������!����OK����	����$���2$�1���)�*�����	
#�+��7����������������X	�<.����9`�+�
���������-5��8��,�9)�	��������

�������%�
����
���)�2$(8���*� �

� �
���Q �[G[� �

� �

� �

W.	6��5	6)$��+�3���������������������������������������������������������������������������������������������������������������������

���b
�:�s6�E)�4�EA0)��:�C)�������	
#�+��Define > Material �������3���	����������	������Q �

����!1������ �>"�Steel����	��'�A#1���!�����	�Modify/Show Material�����$��������Q �

����!1�)�,$!.���	�����2$ �*k����Q ��J��`)[Gpf� �
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�

� �
���Q �[Gp� �

� �

+L='�T	#1�5	6)$��+�3���

Define >Area Sections >Add New Section� �
�e
:	
#+�������Q �[G�L��)����!1��
�*�� �

• Section ����������������������������������������������������������������������
A6��=�1��	�
��2$ ���)��	��*� 

• Type������������������������������������������������������D
1���%	����9��
���	�#:	2$ ���)�'�A#1���	*� 

• Material����������������������������������������������������������������6�E)�D
1�����2$ ���)�'�A#1���	�s*� 

• Tickness�����������������������������������0u�����0!��	�#:	��)�A?���
���2$ ���)��	����	�* 

 

���!(&	�Bending���������!(&	�����0!�	�#:	��)�A?Membrane�����������	����0�u�	��#:	��)�A�?

2$ ���)��	��*�� �
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�

� �
��Q �[GL� �

� �

+=<�T	#1�:9	>��+�3���

J�C)�,���!(&�� 1�)�)2$%���)�S�E#����	�-5�8*� �

� �

����=>��T	#1�5	6)$��C	6
<���

	�� 	-��./0�1	2�����3	�����456��	7,	8�����	��� �
� �

C	6
<�:9	>��+=<T	#1�� �

��	���9:���	;<������������� �!;�������;������Assign>Frame/Line >Frame Section����

��!(&Find this Property ���=�1�TRUSS��������!���^<�+��'��A#1���	OK��	����$���2$�1����)��*������

�2$1�
���)����%�
�����������������"���%����������	��&����"���	���	�@�#A)����-5��8)�����S�E�#����	���c1��	
�)

2$%�*�� �

+L='T	#1�5	6)$��C	6
<���

�������$����	����%�
��	
#+�����������9`+�Select > Select > Area Section���	���/1����

��	
#�+�����'��A#1��Assign > Area > Section������2$� ����)�����!1��	�������Q �����!(�&�������
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Sections ����r
��)�=�1��%
����=�1����,�&��������	��9`+�Deck��2��
���������:�C)�m���'��A#1���

��!��OK��	���$�2$1���)*� �

� �

�+O�0	
'��	��G.	7�+�3���

�	
#+����> Load Case�Define������Q �[Gv�	�������)�����!1�2$� �*���!(�&�	��Load Name��	����

�����=�1�����	���1�Live����	������������������������($6�Type�4	����Live����'��A#1���	���R���?����	�	���

��!(&	�Self Weight MultiPlier���	����K;��)��2$ �*� �

� �
��Q �[Gv� �

+L='T	#1���	��	��C	6
<�� �
�������$����	����%�
��	
#+�����������9`+Select > Select > Area Section �������	���/1

����	
#�+�����������'��A#1�kShellf�Uniform�Assign > Area loads >�����Q ��[Gh���	������!1���

�)2$ ���*��!(&��Load Case Name�����)�	������r
��)�� �>"��� C��Dead Load��'��A#1���	�

��!(&�	��Uniform Load	��8)�2mi100Kg�)��	����	��2$ �*���!(&�	�Direction���� �>"�

Gravity2$ ���)�'�A#1���	��*� �

� �

� �
���Q �[Gh� �
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� �

���1���	�T"	�����!��������������K#+������!���� �����%�
������'��A#1���	�����&��9`+������ 1�!%��

���)	����	�T"	����!(&����!(�&����Load Case Name�����'��A#1���	����1�	����
� ����	����!(�&

Load����	�
��1��Uniform Load���8)�	��	��2mi 500Kg�2$�� �����)��	����	�*���!(��&�7����	��

	���N����������
 .�����#("��	�T"	�����2��������K#+����1�*�����%��$1��N�������9K�;��	�� F11��

F22���	��+��
������0u�	�#:	����r
��)���*�	
#+����� �

Assign > Area >Area Stiffness Modifiers� �
���!���������!(&�	���K;�R��?����r
��) F11�F22����)�oT��2$ �*k���Q ��J��`)[GZf 

� �

� �
���Q �[GZ� �

���� �>"���	�������$�������������Q ���������r
���)Display Option For Active Window��

���"����!1*�!(&���General �� �>"�Fill Objects�$ ����C:��	�*� �

� �

�,	'����L0��

��%�#)�	����4�EA0)���# �����^����	����)�,$�9���	����+��2$ �*�,$�9��������	
#+������ �

Analyze >  Set Analysis  Option…       �����K#�+����� ��	���������Q���������������!1���	

�.��$�������,���2$1���)�*�$������������	��������!OK������	����e
�:���Q �����_��2�
�����)�*��������9��,�$�

��)�����!�����	�����$����)���2$�1��*���!(�&	�Case Name������6�������r
���)��� �>"���9�,�$��

Modal�'�A#1���	���!(&���� Click to ��!��Run�Run/Do Not�����C:��	��2$� ����)*���������)�

�������6��Modal����
0�1�,$�9�*���^<�+���	����!����Run Now ������$���2$�1����)����������4��$�!�

,$�9����
����u�*�����^����,$�9��4�$�!������������	������(6�)�,���)��.$�	
;�	����������#:�"�4	
�;��#�+
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������*	
#��+��ANALYSIS COMPLETE ���
�������)��%���x*��4	
E�� ������$u�	����������%����`�

,$�9����Q ��	���
3
)��6�!#�����%	��0%�����+	�������d;������t�"�1��*� �

� �

%/�����L0�,���T	7�N"	
�������

�1
���)�2$(8�����"�������)�1�����%��3���*� �

F* �.$:��"���%��3��� 

H*  #)���%��3���� 

��%��3�����
���)��	��.$:��"�������	
#+�����	�� #)���%��3���������V��!1���)��+� %���	�� �

�File > Show Input /Ouput Text Files                        ��� �
�
���!1���%�0���)*�������N������9������%��$1�=��"���������%�0���)���������D
���1	�������%@����#A)��	
#���+���������������������������������������������������������
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